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This work is licensed under CC-BY 4.0 International. 

Illustration reprinted from Pete Bankhead.

https://github.com/HMS-IAC/qupath-workshop?tab=CC-BY-4.0-1-ov-file


Get the course materials

One-stop resource for everything we'll cover today
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https://hms-iac.github.io/qupath-workshop

https://hms-iac.github.io/qupath-workshop


Let’s download an example image
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1. Browse to the workshop website > 
2. Download the .vsi whole-slide image
3. Once done, unzip it
4. Save it 
4. Right-click on the installer file > Open > Confirm Open



Workshop plan
1. Introduction to digital image analysis
2. Installing QuPath and your first project
3. GUI layout and toolbars
4. Introducing objects: annotations and detections
5. Saving, sharing and receiving QuPath projects
6. Nuclei detection and measurements (incl. StarDist)
7. Cell classification 
8. Automating tissue annotations (pixel classifier)
9. Advance topic: scripting and workflows
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Self-introductions

1. My name is Antoine
2. My position is as an Associate in Systems Biology
3. My lab is the Image Analysis Collaboratory and the Megason Lab
4. I have confocal microscopy images of cancer tissues, embryos, …
5. A fun fact about me is I used to be a brewer
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Goals

1. Motivate the use of algorithms in image analysis
2. Introduce some image-analysis nomenclature
3. Learn to use QuPath effectively and reproducibly
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Reasons to learn image processing

• Make pretty pictures (processing)
• publications, talks, websites, ...

• Get numbers out of pictures (analysis)
• cell sizes, vessel lengths, GPF expression level, ...

• Make experiment possible (automation)
• whole-genome screen: millions of images

• Objectivity and Reproducibility
• in science, it’s your duty!
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Reasons not to learn image processing

none
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Why should we analyze images 
with computers at all? 
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Color perception and pattern recognition is individual – 
science less so

https://www.moillusions.com/perfect-circles-optical-illusion/ http://www.brainbashers.com
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Color perception and pattern recognition is individual – 
science less so

https://www.moillusions.com/perfect-circles-optical-illusion/ http://www.brainbashers.com
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“Each human brain is a very 
complex neural network trained on 

different data – predictions will vary”
Antoine

In other words, 
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A typical image analysis workflow
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Image processing 
vs analysis
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What is an image?
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Image 

Analysis 

Collaboratory

Images in publications and presentations  

should be used to communicate a finding...  

not be the finding
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Display your images
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Display images: color, brightness & contrast
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• If you are imaging a blue fluorophore, 
you are not forced to display it in blue!

• Pixel histogram represents the 
distribution of pixel values in the 
image

• LUT range

https://imagej.net/Fiji  https://fiji.sc/ https://imagej.net https://imagej.nih.gov/ij/    

Image 

Analysis 

Collaboratory

Display a file: Brightness & Contrast

Image > Adjust > Brightness/Contrast (cmd) + shift + c

 Interactively change the displayed  

brightness and contrast of the active image.

*You are NOT changing the pixels values, you are just 

changing how the image is displayed  

(unless you click on the “Apply” button).
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Save the downloaded example image (cont.)
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1. Browse to the workshop website > 
2. Download the .vsi whole-slide image (~2-5 min)
3. Create a folder named qupath_workshop (outside of your 
downloads folder)
4. Once the download is finished, unzip
5. Save the unzipped folder in the newly created qupath_workshop 
folder



Introduction to QuPath

You after this 
workshop

You before this 
workshop
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Illustration reprinted from Pete Bankhead.



What is QuPath? 

QuPath is an open-source software for 
bioimage analysis

• Developed and maintained by Pete 
Bankhead and his team at the University of 
Edinburgh

Key features: 
1. Performant when working with very 

large 2D images, like those produced 
by slide scanner

2. Extremely well maintained

The world’s most 
complex biomedical 

research

The open-source 
image analysis 
software Pete 
Bankhead has 
been thanklessly 
developing in the 
UK since 2016

Adapted from https://xkcd.com/2347/
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What is QuPath good at? 

• It has a nice graphical user interface (GUI)
• It was designed to handle very large 2D images 
• It supports common image analysis tasks: segmentation, 

annotation,  feature analysis, and classification
• It support extensive visualization options
• It integrates with many other existing tools (Stardist, ImageJ, …)
• It support scripting (Groovy, akin to Java)
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What is QuPath not good at? 

• Limited to 2D images
• Only supports the visualization of single planes

• Does not support all file format (e.g. zarr/NGFF) 
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Installing Qupath

https://xkcd.com/1654/
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Download QuPath
1. Go to https://qupath.github.io/ (see useful links on website)
2. Download the installer for the latest version
NB: we recommend the .msi file for Windows users

4. Right-click on the installer file > Open > Confirm Open

3. Choose your OS
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https://qupath.github.io/


For macOS users
Confirm that QuPath installer is not a malware
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Download QuPath

Follow the steps of the installer
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Manage different QuPath versions
macOS users: 

• Applications > multiple versions of QuPath installed > Choose the latest one
• Cmd + space, then choose from the list of available versions

Windows users:
• C:\Program Files\QuPath
• Opening your application manager should prompt you the different version of QuPath that have been 

downloaded

Linux users: 
• I don’t know

Trick: using multiple versions of QuPath allows to easily run more than one app at the same 
time on your laptop (i.e. doing so from a single app would require launching each instance from 
a separate terminal on macOS). 
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Open the QuPath application
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Welcome to QuPath!

Useful resources: 

Documentation: 
https://qupath.readthedocs.io/en/0.5/

QuPath-speficic place in ‘The Forum’:  
https://forum.image.sc/tag/qupath

Updater

For now, let’s get started
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Graphic User Interface (GUI) – intro
Menu bar

Analysis panel
Viewer (here cropped)

Tool bar
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Getting help

• In-app documentation: Help menu

• QuPath documentation: https://qupath.github.io/ 

• The Forum: https://forum.image.sc/ 

• During this workshop, ask questions to your neighbors, the TA’s 
and me! 
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Your first project in QuPath
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Classification of proliferating cancer cells in solid tumors

• Whole-slide image
• Already been stitched

• 4 channels 
• DAPI
• Keratin (FITC)
• Fibronectin (TRITC)
• Ki67 (CY5)

At the end of this course: 
you will have classified 
proliferating (Ki67) cancer 
cells and reveal their spatial 
distribution to regions with 
high-fibronectin content Courtesy of Nina Kozlova, PhD
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Download the image from the shared folder
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1. Download the whole folder from the Google Drive
1. Image size: ~3GB; it will take a minute or two to 

download
2. Unzip it
3. Transfer the image in a new Images folder in your 

QuPath project folder

1.

2.



Key concept: QuPath project

• Projects are the way to organize your work in QuPath

• In other words, they are folders
• Group together images
• Organize data, scripts, classifiers, etc
• They only save data, not the original images

• Allow you to share your work with other QuPath users
• Always send the images along!
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How to create a project?

• Create project button
  or
• File > Project… > Create project

• ! Make sure to create an empty folder for your 
project
• Sometimes, you have to do this twice in the empty folder
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Anatomy of a QuPath project
After a bit of time working on it…
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Add an image to your project
1. Check your emails! Download this folder containing an example 

whole-slide image

2. Add an image
• Add images button 

• Select the .vsi file
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Add an image to your project
3. Select the .vsi image 
using Choose files or 
drag-and-drop

4. Use default settings

5. Click import 

3. 

5. 
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Set image type

• Other image types are supported: Brightfield H&E, H-DAB, other brightfield 
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Yay! We have a QuPath project with an image
Double-click an image to open it in the viewer
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QuPath works on copies of your original files

• QuPath access the image pixels and metadata via an image server
• Akin to a copy of the original file

• Manipulating files within a QuPath project will never modify the 
original files or pixels
• Deleting, duplicating, processing, etc will not be reflected in your original 

files
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QuPath projects are portable

• Sharing a project:
• Zip up the entire project directory
• Email it to your collaborators
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The project folder only contains QuPath objects and data, unless you had 
placed them there. Ensure that they can access the actual image files.



QuPath projects are portable

• Receiving a project:
• The project still contains image paths specific to the local machine of the 

sender
• If you move the image, you will be prompted to update the file path

Image Analysis Collaboratory - QuPath workshop 51



QuPath 
Graphical User Interface

(GUI)
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Graphic User Interface (GUI)
Menu bar

Analysis panel
QuPath Viewer (here cropped)

Toolbar
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Analysis Panel
• Project tab > right-click 

on an image
• Open, remove, rename 

and duplicate images
• Edit metadata
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Analysis Panel
• Image tab

• Name and image file path
• Magnification: 20x
• Pixel type, width and height are 

crucial for scale calibration
• Dimensions: 4 channels + 2D
• Pyramid: level of downsampling in 

the viewer
• Image type: previously set to 

fluorescence
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QuPath viewer Viewer

Scale bar

Mini-map: 
overview

Info bar: 
pixel coord 
and valueImage Analysis Collaboratory - QuPath workshop 56



Multi-viewer
• Right-click in the viewer
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Graphic User Interface (GUI)
Menu bar

Analysis panel
QuPath Viewer (here cropped)

Toolbar
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Toolbar
Toolbar
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Toolbar

Preferences
Settings, GUI 

customization, 
extensions, … 
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Toolbar

Interactive Help
Provides contextual 
help based on your 

cursor location

Example when my cursor is on the paint brush tool 
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Toolbar

Annotation tools
• M key: move tool
• R key: draw a rectangle annotation
• O key: draw an ellipse annotation
• B key: paint with a brush
• W key: draw with a wand tool
• And many more!

M R O B W Shift+S

Annotation tools are also accessible in the Tools menu
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Toolbar

Brightness and contrast
• Toggle on/off channels
• Adjust LUT range
• Visualize intensity histogram

Shift+C

Example for FITC (Keratin) channelImage Analysis Collaboratory - QuPath workshop 63



QuPath pro-tip: command list

Command/Control + L
Opens a dialogue to 

search for any command 
using keyword 

For example, search for 
‘brightness’
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Exercises 1: QuPath projects and GUI
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Practice time



Introducing objects: 
annotations and detections
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Key concept: QuPath objects

• Objects are a ‘thing’ in an image which encapsulates not only its 
shape but also some properties about it

• Annotations: Objects that you usually create yourself, by drawing on the 
image
• They are flexible, up to ~100 per image
• Can be edited
• Often used to define regions

• Detections: Objects that QuPath usually creates for you
• They are efficient, up to ~millions per image
• Can be deleted but not edited
• Often used to define cells
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Analysis Panel
• Annotations tab

• Annotation list lets you 
select, delete

• Right-click to lock or edit 
properties (name, color)

• Shift or Command/Control to 
multi-select

Annotation list Classification list
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How to create manual annotations?

Annotation tools
• M key: move tool
• R key: draw a rectangle annotation
• O key: draw an ellipse annotation
• B key: paint with a brush
• W key: draw with a wand tool
• And many more!

M R O B W Shift+S

Select one of the annotation tools from the toolbar then scribble on the image!

Remember to always 
lock your annotation 
to prevent accidental 

editing!
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Exercises 2: QuPath manual annotations
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Practice time



Recreate these annotations
Decide on which annotations tool from the toolbar is best to do so
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Create a region of interest with the annotation tools
In the TRITC channel (fibronectin), create a region of interest that enclose high-
fibronectin content regions

Once you have finished 
your annotation, lock it:

 
Right-click in the viewer 

> Annotations > Lock

or 

Right-click on the 
annotation in the 

analysis panel > Lock
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Cell detection
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Cell detection
• QuPath offers three main options: 

1. Built-in cell segmentation algorithm, based on nucleus thresholding 
and cell body expansion

2. StarDist as an extension (DL)
3. Cellpose as an extension (DL) – not covered here

• All yield Cell Detections objects that will have shape and intensity 
measurements for nucleus, cell and membrane

• Detection can be computationally intensive so we will start from the region 
of interest
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Cell detection
1. Built-in cell segmentation algorithm, based on nucleus thresholding and 

cell body expansion

Note that positive cell detection allows 
for multi-class segmentation on the fly
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Cell detection parameters

Channel e.g. DAPI 

The resolution of the image used in the 
segmentation algorithm
• Enter 0 for full resolution
• Default 0.5 typically good trade-off 

between cost and details
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Cell detection parameters

Radius of area used for 
background subtraction

Radius of median filter 
(smoothing): 
• Enter 0 to disable
• Higher values will 

smooth off details

Radius of gaussian filter 
(smoothing): 
• Enter 0 to disable
• Higher values will 

smooth off details

Allowed area interval for 
detections; nuclei detection is 
removed if outside of the interval 
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Cell detection parameters
Minimum signal intensity of 
nuclei relative to backgroundUses roundness of 

detections shape to 
split clusters/clumps; 
keep it ticked for 
most usages

How much to expand nuclei to 
get cell boundaries
• Enter 0 to disable 
• Enter small values 0 – 2 for 

peri-nuclear measurements
• Enter values ~5 for cytoplasm 

measurements, depending on 
tissues

If ticked, will generate measurements 
specific to each detected nuclei and 
inferred cytoplasm
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Cell detection with default parameters

Hierarchy tab
• Detection list
• Nested in its 

parent 
annotation (ROI)

• Note the cell 
count
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Note on the hierarchy of objects in QuPath
• QuPath allows to nest objects in one another to organize your 

projects
• Child-parent link
• Very useful to organize and restrict the analysis to parts of an image
• Can be used to restrict image processing within a ROI or a detected tissue 

region
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Exercise 3.a: QuPath cell detection
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Practice time



Exercise: explore parameters
• I found that default parameters tend to over-segment nuclei so adapted the 

parameters to be slightly stricter (min area and threshold increased)
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Duplicate your image
• Copy your cell detection results for 

future work on it
• Project tab > Image list > Option+click

or right-click on the image name > 
Duplicate image
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It duplicates QuPath objects, 
not the actual image



Detecting cells with an extra condition

• Adds an extra step of 
classifying all cells as 
positive or negative 
immediately according 
to staining intensity
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• Analyze > Cell detection > Positive cell detection



Deep learning-based cell segmentation
• DL-based methods can typically capture more complex patterns, tend to 

mitigate human bias such as threshold hand-picking
• However, they are more computationally expensive and often need fine-

tuning or re-training for specific applications

• StarDist is a deep learning model trained to detect specific kinds of nuclei in 
different kinds of image 
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Installing StarDist extension in QuPath
• Browse to 

https://github.com/qupath/qupath-
extension-stardist/releases

• Download the .jar file compatible with 
your QuPath version
• For this workshop, get qupath-

extension-stardist-0.5.0.jar

• Drag and drop the .jar file onto QuPath
main window, and… that’s it!
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Using StarDist extension in QuPath
• Go to Extensions tab > StarDist  > StardDist fluorescence cell detection script

No click-based solution yet!
But scripts are already written for you…
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Using StarDist extension in QuPath
• Requires to load a pre-trained model (basically the weights)

Note: StarDist is rather 
computationally expensive, 
typically can take ~ 5 min 
for 100k detections
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StarDist for 2D segmentation of DAPI-stained nuclei

• Some pre-trained StarDist models are freely available as .pb files (frozen)

• Go to https://github.com/qupath/models/raw/main/stardist and download the 
dsb2018_heavy_augment.pb model

dsb2018_heavy_augment.pb is pre-
trained for 2D fluorescence images 
(one detection channel)
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https://github.com/qupath/models/raw/main/stardist


Using StarDist extension in QuPath
• Change the value of the modelPath variable to an actual StarDist model path in 

the script
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Make sure to 
select the ROI in 

QuPath before 
running the script.Change the 

channel 
name



Allow cell boundaries to bleed over the ROI
• Add .constrainToParent(false) 
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Add this 
line



Do not constrain cell expansion with neighbors
• Add .ignoreCellOverlaps(true) 
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Add this 
line



Exercise 3.b: QuPath cell detection with StarDist
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Compare StarDist to threshold-based cell detection, 
what do you observe?

94

StarDist can not segmentStarDist can segment



Cell detection measurements

Image Analysis Collaboratory - QuPath workshop 97



Detection measurements
• Each detection object (i.e. a 

cell) has its measurement list
• Intensity features
• Haralick (texture) features
• Shape features
• Smoothed features

• Annotations tab > select a cell 
in the viewer > inspect its 
measurements list 

By default, basic intensity and 
shape features are calculated
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Calculating measurements
• Analyze > Calculate features > 

Add intensity features 

Tick boxes of the channels and 
features of interest 
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Need a custom feature? Script it!



Visualizing measurements

Columns: measurements

Rows: cells 

• Measure > Show detection measurements
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Visualizing measurement distributions
• Measure > Show detection measurements

FYI, it is not possible to export 
distribution plots… 
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Visualizing measurements as heat maps
• Measure > Show measurement maps

Measurements list

Your favorite color map, 
and its range of value
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Export measurements the right way
• Measure > Export measurements • Drag an image from Available to Selected

Output file 
location

Measurement type to be 
exported

File type (.tsv, .csv)

List of measurements to 
include in the export

Save your 
results 

first!
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Cell classification
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What is cell classification? 



What is cell classification? 

• Cell classification in image analysis is sorting different types of 
cells into groups based on their features or characteristics, such 
as shape, color, position, neighbors, etc.

• If visually you can’t discriminate cells in your images, then your 
algorithm might be separating cell on very fine differences (careful of 
overfitting)



Cell classification in QuPath

• Single measurement classifier

• Composite thresholder: combine single measurement thresholders 
together

• Train a machine learning classifier



Create a class named ‘Keratin+’

• Annotations tab > Classification 
list >       > Add/Remove... > Add 
class

1. 

2. 
Default classes are channel names.
We’ll change that. 

3. 



1. 

2. 

Create a second class named ‘Ki67+’

• Annotations tab > Classification 
list >       > Add/Remove... > Add 
class

Default classes are channel names.
We’ll change that. 

3. 



Change the color of a class
• Double click on the class > Edit class > Choose a new color > OK

Your favorite color.

1. 

By default, classes are 
populated by image channels. 



Simple measurement classifier on Keratin 
signal intensity (FITC channel)
• Classify > Object classification > Create single measurement classifier

Shows classification 
on the fly

!! Save your 
classifier



Simple measurement classifier on Ki67 signal 
intensity (CY5 channel)
• Classify > Object classification > Create single measurement classifier



Exercise 4.a: single-measurement classifier

Practice time



Combine single measurement classifiers into a 
composite classifier
• Classify > Object classification > Create composite classifier

Select a classifier by 
moving it onto the 

‘Selected’ list.

A name is required to 
‘Save & apply’



Exercise 4.b: composite classifier

Practice time



Reset detection classes
• Classify > Object classification > Reset 

detection classifications

Populate classes in the classification panel
• Annotations tab > 

Classification list >       > 
Populate from existing 
objects > All classes 
(including sub-classes)

1. 

2. 



Object classification using machine learning

• Detections (and annotations) can be classified into classes using a ML 
classifier

• Classification requires measurements!

• Object classifiers are trained using manual annotations of 2 or more 
classes
• Need to create some training data points

• Live demo of object classification using ML



Reset your detection classes!



Train an object classifier: create classes
• Annotations tab > Classification list >       > Add/Remove... > Add class

• Create 4 classes: 
• Keratin+
• Keratin-
• Ki67+
• Ki67-



Train an object classifier: training data points
• > Add > Label ~10 for each class

• Assign each training data set a class: 
• Select the annotation set
• Select the class

Training data

To remove a single point: 
Option + click (Mac) or left-click 

Click edit to change color



Train an object classifier: training data points
• Assign each training data set a class in the Annotations tab

1.

2.

3.

Make sure to lock your annotation: Ctrl+click > Lock



Train an object classifier
• Classify > Object classification > Train object classifier 



Train an object classifier
• Classify > Object classification > Train object classifier 

Model type (RT, ANN, k-NN)

Features: choose Selected measurements 
and click Select to restrict the feature space

Name it to save it.



Combine multiple ML classifiers together
• Classify > Object classification > Create composite classifier

8 resulting classes!
+ ignore*



Refine your classifier
• Add more training data points

• Classification results will change in real time if ‘Live update’ option is 
enabled

• Typically, fewer, but well-chosen features provides more robust 
results



Visualizing results using density maps
• Analyze > Density maps > Create density maps



Automating tissue identification
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But first, let’s talk smoothing
Intermezzo aperto











Balancing act: smooth enough to “clean up” 
the noise, but not so much as to remove 

important image gradients. 



Back to QuPath
Intermezzo chiuso



Creating a region of interest
In the TRITC channel (fibronectin), create a region of interest that enclose high-
fibronectin content regions aka stromal regions

Once you have finished 
your annotation, lock it:

 
Right-click in the viewer 

> Annotations > Lock

or 

Right-click on the 
annotation in the 

analysis panel > Lock



Pixel-based tissue annotation
• Simplest case of annotation: every pixel get assigned a class based on its 

intensity value – or is a given pixel above or below a certain numeric value?

Resolution: trade-off between 
details and computational cost

Pre-process images with filters e.g. 
smooth out noise with gaussian 
(sigma is the kernel size in pixels)

Decide to use ROI or 
the full image Save your 

thresholder to use it! 



Interactive visualization of thresholding results

Try varying the value 
of the different 

parameters! 

Create a class 
‘Stroma’



Create annotations from pixel classifier
• Real-time visualization of 

results, once happy with it: 
1. Save your thresholder
2. Select ROI
3. Click Create objects
4. Keep default 

parameters > OK



Create annotations from pixel classifier

Notice the new annotation named 
’Stroma’ in the Annotations list



Fully annotated image



Spatial information: signed distance
• Analyze > Spatial analysis > Signed distance to annotations 2D

• Calculates the signed distance (2D euclidian) between cells and 
annotations
• If a cell lies inside the annotation: negative distance

• If a cell lies outside the annotation: positive distance



Spatial information: signed distance
• Measure > Show detection measurements

Export measurements 
table and use Python/R for 

visualization based on 
classes



Scripting, workflows and batch processing
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Scripting in QuPath
• QuPath uses Groovy, a scripting language with Java-like syntax
• Some fun facts about Groovy: 

• Created by James Strachan in 2003
• Open-source (under the Apache License 2.0)
• Groovy is a superset of Java and its syntax is Java-like
• Bonus: dynamically typed (vs Java being statically typed)

for loop in Groovy



Scripting in QuPath
• Automate > Script editor



Hello World!
• Automate > Script editor

Editor (where you 
write code)

Console

Run script



Automate your workflows without coding
QuPath uses Workflows to represent 
sequences of steps that have been applied to 
an image (commands run but also the 
parameters used). 

• Analysis panel > Workflow tab

• The Command history is a record of most  
processing that has been done to the 
currently open image



Clean your workflow for cell detection and classification

1.

2.

Edit the sequence of steps in the workflow using right-click



Save and run a script

1.

2.

3. 4.



Scripts can be repeated on a batch of images
QuPath allows for batch processing: scripts will run on multiple images loaded in 
the project.

• Run > Run for project

Select images you wish to run the script on.



Further resources
• QuPath documentation

• Scripting: 
https://qupath.readthedocs.io/en/latest/docs/scripting/overview.html

• QuPath’s API docs: https://qupath.github.io/javadoc/docs/ 

• The Forum
• Where to contact the developers of most image analysis tools
• If you have a question, likely someone else already asked

https://qupath.readthedocs.io/en/latest/docs/scripting/overview.html
https://qupath.github.io/javadoc/docs/


QuPath on O2
Ranit Karmakar



Give us your feedback!

https://tinyurl.com/52hu7bkt



Further resources
• QuPath documentation

• Scripting: 
https://qupath.readthedocs.io/en/latest/docs/scripting/overview.html

• QuPath’s API docs: https://qupath.github.io/javadoc/docs/ 

• The Forum
• Where to contact the developers of most image analysis tools
• If you have a question, likely someone else already asked
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